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Rotating



Rotating

• Various rotation 
commands can be 
applied to images and 
also individual layers in 
layered images

• This can be useful for 
positioning items and 
also for correcting the 
orientation of an image 
that is on its side or 
upside down



Rotating a whole image

• Select Image> 
Rotate from the 
Menu bar



Rotating a whole image

• Select a rotation 
option from the 
menu



Rotating a whole image

• Image is rotated to 
the right



Rotating a whole image

• If you start with an 
image that is not 
strait you can…



Rotating a whole image

• Select Custom to 
enter your own 
value for the 
amount you want 
an image rotated



Rotating a whole image

• Select Custom to 
enter your own 
value for the 
amount you want 
an image rotated



Rotating a whole image

• Click on the OK 
button



Rotating a whole image

• Image is straitened 
to left by 5 points



Rotating a layer

• To rotate separate 
layers within an 
image, open an 
image that 
consists of two or 
more layers

• Select one of the 
layers in the 
Layers palette



Rotating a layer

• Select Image 
Rotate from the 
Menu bar



Rotating a layer

• Select a layer 
rotation option 
from the menu



Rotating a layer

• The selected layer 
is rotated 
independently



Rotating tip

• If an image is only 
slightly misaligned, then 
only a small angle figure 
is required in the Rotate 
Canvas dialog box

• A figure of 1 or 2 can 
sometimes be sufficient



Transforming



Transforming

• The Transform 
commands can be used 
to resize an image and to 
apply some basic 
distortion techniques 

• These commands can be 
accessed by selecting 
Image> Transform from 
the Menu bar



Transforming note

• The other options from 
the Transform menu are 
Skew, Distort and 
Perspective

• These can be accessed 
and applied in a similar 
way to the Free 
Transform option



Free Transform

• Select 
Image>Transform>
Free Transform 
from the Menu bar

• Click OK if you are 
prompted to make 
the background a 
layer



Free Transform

• Click and drag 
here to transform 
the vertical size of 
the image



Free Transform

• Click and drag 
here to transform 
the horizontal size 
of the image



Free Transform

• Click and drag 
here to transform 
the vertical and 
horizontal size of 
the image

• Hold down Shift to 
transform it in 
proportion



Magnification



Magnification

• There are a number of 
ways in Elements in 
which the magnification 
at which an image is 
being viewed can be 
increased or decreased



Magnification

• This can be useful if you 
want to zoom in on a 
particular part of an 
image, for editing 
purposes, or it you want 
to view a whole image to 
see the result of editing 
effects that have been 
applied



Magnification

• The View menu can be 
used to display rulers at 
the top and left of an 
image, which can be 
useful for precise 
measurement and 
placement. 

• There is also a command 
for displaying a grid over 
the top of the whole 
image



View menu

• Select View from 
the Menu bar and 
select one of the 
options from the 
View menu



Zoom tool

• Select the Zoom 
tool from the 
Toolbox



Zoom tool

• Click once on an 
image to enlarge it 
(usually by 100% 
each time)

• Hold down Alt and 
click to decrease 
the magnification



Zoom tool

• Click once on an 
image to enlarge it 
(usually by 100% 
each time)

• Hold down Alt and 
click to decrease 
the magnification



Zoom tool

• Click once on an 
image to enlarge it 
(usually by 100% 
each time)

• Hold down Alt and 
click to decrease 
the magnification



Zoom tool

• Click once on an 
image to enlarge it 
(usually by 100% 
each time)

• Hold down Alt and 
click to decrease 
the magnification



Navigator Palette

• This can he used 
to move around an 
image and also 
magnify certain 
areas



Navigator Palette

• The Navigator also 
has buttons for 
zooming in and out

• These are located 
at the left and right 
of the slider



Navigator Palette

• The Navigator 
palette can be 
used to move 
around an image 
and also magnify 
certain areas



Navigator Palette

• Access the 
Navigator palette 
by selecting 
Window>Navigator
from the Menu bar



Navigator Palette

• Drag this slider to 
magnify the area of 
the image within 
the red rectangle



Navigator Palette

• Drag the rectangle 
to change the area 
of the image that is 
being magnified



Magnification tip

• Click and drag with the 
Zoom tool over a small 
area to increase the 
magnification to the 
maximum, i.e. 1600%

• This can be particularly 
useful when performing 
close-up editing tasks, 
such as removing red-
eye



Eraser



Eraser

• The Eraser tool can be 
used to remove areas of 
an image. In a simple, 
single layer image, this 
can just leave a blank 
hole, which has to be 
filled with something



Eraser

• Eraser, which can be 
used to erase part of the 
background image or a 
layer within it



Eraser

• Background Eraser, 
which can be used to 
remove an uneven 
background



Eraser

• Magic Eraser, which can 
be used to quickly 
remove a solid 
background



Eraser

• If the Contiguous box is 
not checked, this means 
that the background 
color will be removed 
wherever it occurs in the 
image

• If the Contiguous box is 
checked, the background 
color will only be 
removed where it 
touches another area of 
the same color, which is 
not broken by another 
element of the image



Eraser

• The Background Eraser 
tool can be used to 
remove an uneven 
background

• To do this, drag over the 
background with the 
Background Eraser tool 
and, depending on the 
settings in the Options 
bar, everything that it is 
dragged over will be 
removed from the image



Erasing a background

• With the Magic 
Eraser too

• It is possible to 
delete a colored 
background in an 
image



Erasing a background

• Open an image 
with an evenly 
colored 
background



Erasing a background

• Select the Magic 
Eraser and make 
the required 
selections in the 
Options bar

• Make sure the 
Contiguous box is 
not checked



Erasing a background

• Click once on the 
background

• It is removed from 
the image, 
regardless of 
where it occurs



Removing red-
eye



Removing red-eye

• One of the most common 
problems with 
photographs of people, 
whether they are taken 
digitally or with a film-
based camera, is red-eye

• This is caused when the 
camera's flash is used 
and then reflects in the 
subject's pupils



Removing red-eye

• This can create the 
dreaded red-eye effect, 
when the subject can 
unintentionally be 
transformed into a 
demonic character



Removing red-eye

• Unless you have access 
to professional studio 
lighting equipment or 
have a removable flash 
unit that can he 
positioned away from the 
subject's face, sooner or 
later you will capture 
images that contain red-
eye



Removing red-eye

• Elements has recognized 
that removing red-eye is 
one of the top priorities 
for most amateur 
photographers and a 
specific tool tor this 
purpose has been 
included in the Toolbox: 
the Red Eye Removal tool



Removing red-eye

• Open an image 
that contains red-
eye



Removing red-eye

• Drag around the 
affected area until 
it appears at a 
suitable 
magnification



Removing red-eye

• Select the Red Eye 
Removal tool from 
the Toolbox



Removing red-eye

• Click once on the 
red-eye, or drag 
around the 
affected area



Removing red-eye

• The red-eye is 
removed



Removing red-eye tip

• The best way to deal with 
red-eye is to avoid it in 
the first place

• Try using a camera that 
has a red-eye reduction 
function. This uses an 
extra flash, just before 
the picture is taken, to 
diminish the effect of red-
eye



Removing red-eye tip

• Red-eye can be removed 
by clicking near the 
affected area: it does not 
have to be directly on it



Removing red-eye tip

• Red-eye can also be 
removed when images 
are being downloaded 
from the camera

• This is an option in the 
Photo

• Downloader window



Adjusting skin 
tones



Adjusting skin tones

• Skin tones can 
sometimes cause 
problems in digital 
images

• At times they can look 
washed-out and pale or 
contain a slightly 
unnatural color cast



Adjusting skin tones

• This can be edited with 
the Adjust Skin Tones 
function, which can be 
used to improve the skin 
tone of a pale image or 
just to give someone a 
more tanned or healthy 
appearance



Adjusting skin tones

• It is best to make small 
adjustments when editing 
skin tones, otherwise the 
results can look too 
unnatural



Adjusting skin tones

• In the Editor, open 
an image whose 
skin tone you want 
to adjust



Adjusting skin tones

• Select Enhance> 
Adjust Color> 
Adjust Color for 
Skin Tone for Skin 
Tone from the 
Menu bar



Adjusting skin tones

• Click on the image 
to automatically 
adjust the skin 
tone in relation to 
the selected area



Adjusting skin tones

• Drag these sliders 
to alter the amount 
of tan and blush in 
the skin tone



Adjusting skin tones

• Drag this slider to 
edit the overall 
light in the image



Adjusting skin tones

• Click on the OK 
button



Adjusting skin tones

Before After



Straightening an 
image



Straightening an image

• If you use scanned 
images, you will quickly 
discover that it can be 
difficult to capture a 
perfectly straight image

• Invariably, scanned 
images appear at a slight 
angle once the scanning 
process has been 
completed, however 
careful you arc when you 
place the original image 
in the scanner



Straightening an image

• Images can also be 
straightened by selecting 
lmage> 
Rotate>Straighten and 
Crop Image from the 
Menu bar



Straightening an image

• Once they have been 
straightened images can 
also be cropped manually 
using the Crop tool in the 
Toolbox



Straightening an image

• Open the image 
that requires to be 
straightened



Straightening an image

• Select the 
Straighten tool 
from the Toolbox



Straightening an image

• Drag on the image 
at the angle by 
which you want it 
to be straightened



Straightening an image

• The image is 
straightened 
according to the 
angle used



Straightening an image

• Crop image



Straightening an image

Before AfterStraiten



Straightening an image tip

• When scanning images it 
is best not to spend too 
much time trying to get 
the image straight

• This is because it can be 
a frustrating process and 
also because of the ease 
with which Elements can 
cure the problem



General Quick 
Fixes



General Quick Fixes

• To perform general 
orientation and color 
correction tasks with the 
Quick Fix option



General Quick Fixes

• Click here to 
perform an Auto 
Smart Fix edit



General Quick Fixes

• Drag this slider to 
manually edit the 
colors, shadows 
and highlights



General Quick Fixes

• Changes are displayed in 
the main Quick Fix 
window as they are being 
made



General Quick Fixes

• Once Quick Fix changes 
have been made they can 
be applied by clicking on 
the tick icon at the top 
right of the Quick Fix 
window

• Click on the circle with 
the line through it to 
discard the changes



Lighting Quick 
Fixes



Lighting Quick Fixes

• To improve the lighting 
and contrast in an image 
with the Quick fix option



Lighting Quick Fixes

• Click on the Auto 
buttons to 
automatically 
adjust the levels 
and contrast in an 
image



Lighting Quick Fixes

• Drag these sliders 
to manually adjust 
the shadows, 
highlights and 
midtones in an 
image



Color Quick 
Fixes



Color Quick Fixes

• To improve the color in 
an image with the Quick 
Fix option



Color Quick Fixes

• To improve the color in 
an image with the Quick 
Fix option



Color Quick Fixes

• Click on the Auto 
button to 
automatically 
adjust the colors in 
an image



Color Quick Fixes

• Drag these sliders 
to manually adjust 
the colors in an 
image



Sharpening 
Quick Fixes



Sharpening Quick Fixes

• To improve the definition 
in an image with the 
Quick Fix option…



Sharpening Quick Fixes

• Click on the Auto 
button to 
automatically 
adjust the 
sharpness in an 
image



Sharpening Quick Fixes

• Drag this slider to 
manually adjust 
the sharpening in 
an image



Sharpening Quick Fixes

• Sharpening works by 
emphasizing the edges 
between adjoining pixels 
in an image



Sharpening Quick Fixes

• If too much sharpening is 
applied, the affected area 
could appear almost 
serrated since the lines 
between adjacent pixels 
will become too 
noticeable



Sharpening Quick Fixes

• When the Quick Fix 
editing has been 
completed, you can 
return to the main editing 
window by clicking the 
Full Edit tab on the 
Shortcuts bar
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